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1. Introduction

Stages Report Wizard is a powerful way to illustrate the progress
your learners have made over a period of time. Whether you are
looking for increased time on task or understanding of specific
academic content, Stages Report Wizard can provide visual and

Bloo: dics numeric representations that tell the story.

have lots of
saved Stages

reports, how Using reports that you save from Stages assessment software, Stages

B I use th Report Wizard can create graphs that show overall growth in
data to account accuracy and independence, tables that show content mastery, and
for learner summary reports for alternate assessments, learner portfolios, or
progress? meetings to discuss learner progress.

From a set of saved Stages report files for your learner, Stages Report
Wizard will automatically generate the following;:

Stage Four: Assess Counting - Accuracy

Bar Graphs and Line Graphs — .
graphical illustrations of many aspects
of the data, with optional goal line
and arrow showing optimal direction
toward success.

% Correct on First Try

Content Mastery —tables showing the == e
. 0% 100% Ta%
percent correct on first try for each bwo 0% 100%  74%
) 3 / i three 0% 100% 9%
content item during the first session, the D 0% 100% 5%
. . : I've 0% 100% 26%
final session, and average for all sessions. | _/ B Lawe o
SEVEN 0% 100% 26%
eight 0% 0% 0%
nine 0% 100% 25%
ten 0% 0% 0%

Annotated Report—a report from a single
session with your comments.
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Activity Summary —a comprehensive summary of

many sessions, which you can customize with graphs
and the Content Mastery table, your comments and
information about the learner. You can print and save
this document for a learner’s portfolio, share it
electronically with colleagues and parents, or use it as a
learner progress report.

This User Guide will show you how to use Stages Report Wizard to
put together the most effective demonstrations of what your learners
have achieved.

2. Getting Started

System Requirements

In order to run Stages Report Wizard, your computer must have the
following minimum configuration:

Windows:

166 MHz Intel Pentium processor or greater
Windows 95, 98, ME, NT4, 2000, NT, XP

32 MB or more of installed RAM

800x600 resolution monitor

CD-ROM drive

Macintosh:

120 MHz PowerPC

MAC OS 8.1 to 9.x (OS X in Classic mode)
32 MB or more of installed RAM

800x600 resolution monitor

CD-ROM drive

page 2 Stages Report Wizard User Guide




Starting Stages Report Wizard

=

Tips

ed

To start Stages Report Wizard, insert the CD in your CD-ROM drive.

o On a Windows computer, the program should start up
automatically.

o On a Macintosh computer, double-click the icon for the CD (if it
doesn’t open automatically), then double-click the icon for Stages
Report Wizard.

Note that you can copy the contents of the CD to your hard drive and
run Stages Report Wizard from there. However, you will need to keep
the original CD in the CD-ROM drive while you use the program.

When Stages Report Wizard is launched you will see the screen
below. Click the Start button or press any key to begin the program.

E Report
Wizard

" SRAPH * ) + SUMMARY

o e allly crare CONTENT UMMARY oo
T

P

B0 % Correct on First Try

First Final Average
505
one 0% 100% 75%
0% tarny 0% 100% 75%

0 three 0% 100%  75%
four 0% 100% 5%

20% five 0% 100%  25%
six 0% 100%  25%
SEVEN 0% 100%  25%
eight 0% % 0%

nine 0% 100%  25%

ten 0% 0% 0%

May 5, 2003

Jun 23, 2003

Mar 15, 2003

¢ ¢

Assistive Technology, Inc. © 2003 Assistive Technology, Inc

If you have a question about what to do at a screen, click the Tips
button in the upper right corner of the screen or choose “Show Tips
for this screen” from the File menu. You can also use the keyboard
shortcut: Ctrl-T (Windows) or 3T (Macintosh).

Tips related to the currently available features are displayed in a
separate window. Click the Close button in the window to exit Tips.

Assistive Technology, Inc.
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First Time Setup

When you run Stages Report Wizard for the first time, you will see
the screen shown below.

Click the button labeled Create ‘My Stages Reports’ Folder to make a
folder on your computer’s Desktop for all your Stages reports. This
folder will initially contain a “‘Sample Learner’ folder, which contains
a set of reports for each Stage that you can use to become familiar

Create 'My Stages
Reports' Folder

with the program.
. Tips
Welcome to Stages Report Wizard!
You will need to put all your Stages Assessment report files in one folder. Each
learner will have a separate folder within this folder.
Click to create a Reports Folder. E Create My Stages | ——— Create a folder for your
{or locate an existing "My Stages Reports' folder) Reports' Folder learners’ Stages reports.

This button put a folder for your reports on your computer's Desktop.
This folder will have reports for a Sample Learner to help you get started.

Stages Report Wizard will help you add your learners to this folder.

Each time you start up Stages Report Wizard, it will look for the "My
Stages Reports” folder on your Desktop. You will be placing all your
learners” Stages report files here. When you are ready to add learners,
Stages Report Wizard will help you create individual folders for
them. If you have already created folders for your learners, the
program will walk you through the process of adding them to your
Learner List. (See page 8 for details on adding learners.)

You can move the ‘My Stages Reports” folder to any location you
prefer. If you move or rename it, the next time you start up Stages
Report Wizard, it will ask you to find your folder and then
automatically save its new location (see page 35).

page 4 Stages Report Wizard User Guide



Starting with the Sample Learner

Once you have created your “‘My Stages Reports’ folder, you will see
the main screen, shown below. This is the screen you will see each
time you start Stages Report Wizard. It allows you to choose a learner,
manage your list of learners, or open previously saved Activity
Summaries or Annotated Reports.

Learner List

- Stages Report Wizard
\ Tips
Choose a Learner
Click to select a learner's name, then click OK to continue.

The Sample Learner contains Learner List 1
reports for every Stages activity. Use Sample Learner < CIICk ona
the Sample Learner fo learn how to 1 7
use Stages Report Wizard. > earner s name,
When you have finished exploring, oK then CliCk OK,
click the 'Manage Learners' button .
to remove the Sample Learner. or double-chck
To add a learner, click the ‘Add New the name
Learner’ button. Stages Report °
Wizard will help you add the
learner’s name to this list and make 1
a folder in your "My Stages Reports

folder where you can put her Stages
Assessment reports.

Click a butten to update or add to your Learner List.

= Add New
Learner

Other functions:

Open Saved ™ Manage
Quit summaries Learners

Initially, the only name in the Learner List will be Sample Learner.
Later, as you add learners, Stages Report Wizard will create the files it
needs to keep track of them and folders to store their summaries.

To choose a learner, click on a name in the Learner List to select it,
then click the OK button. (You can also double-click the learner’s
name.) This starts you on the process of creating charts and graphs.

Note that you can return to this screen at any time by selecting
“Choose a Different Learner” from the File menu.

You can quit Stages Report Wizard by clicking the Quit button at the
lower left corner of the screen or choosing “Quit” from the File menu.

Open Annotated Reports and Activity Summaries you have
previously saved by clicking the Open Saved Summaries button at
the bottom of the screen. For more information, see pages 18 and 33.

Assistive Technology, Inc.
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Maintaining Your Learner List

Three of the other buttons on the “Choose a Learner” screen offer
additional functions that will become valuable as you use the
program more and more.

7 Edit Each learner has a profile that contains demographic information
Learner about that learner that does not change from activity to activity or
Profile . . . <. . .

from session to session. To view, add or change this information, click
the Edit Learner Profile button. For more information on the Learner
Profiles section of the program, see page 10.

To add learners to the Learner List, click the Add New Learner button.
Stages Report Wizard will create a folder for the new learner, if one
does not already exist, start the learner’s Profile, and add the learner
to the Learner List. If you already put a folder for this learner into
your ‘My Stages Reports” folder, Stages Report Wizard will start the
learner’s Profile and add the learner to the Learner List. In either case,
you will need to put the Stages reports for the learner into his or her
folder, which is inside the “My Stages Reports” folder. For more
information on managing your files, see page 9.

‘ Manage ‘ To remove a learner from the Learner List or find a missing learner,
Learners click the Manage Learners button.

Tips

Remove a Learner from the Learner List

Select a learner, then click the button
to remove the selected learner.

[Sample Learner

Remove Selected
Learner from List

To restore or find a missing
learner, please click below to
locate the learner's folder.

Restore or Find

‘- a Missing Learner

=

Remove Selected | YOU may wish to remove a learner who has moved away, left your
Leamer from List | cags, or transferred to a different school or facility.
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If a learner
moves from
your facility,
send a copy of
his or her
folder or
Activity
Summary
printouts to the
new placement.

Restore or Find
‘. a Missing Learner

Select a folder

Pleaze select a learner's folder.

Click a learner’s name, then click this button to remove a learner from
the Learner List. Removing a learner does not delete the learner’s
folder or any Stages reports. You may leave the learner’s folder in
your ‘My Stages Reports” folder in case you want to restore the
learner’s name to the list (see below).

If you wish to completely delete the learner’s folder and reports,
please refer to your computer’s manual or online help for assistance.

If a learner leaves your facility, it may be useful to send Stages Report
Wizard data to his or her new location. This data could include a copy
of the learner’s folder if Stages and Stages Report Wizard are used
there. Even if Stages isn’t used in the new program, you can send
copies of the printed Activity Summaries and Annotated Reports to
the new service delivery team to help them understand the learner’s
status.

Click the Restore or Find a Missing Learner button if a learner’s name
doesn’t appear in your Learner List. A dialog will open and you can
select the learner’s folder. Note that you can only restore a learner
whose folder is in your “‘My Stages Reports’ folder. If you don’t see
the learner’s folder there, switch to your computer’s Desktop and
move the folder into the ‘My Stages Reports” folder.

Windows: Click the folder name, then the OK button.

Macintosh: Click the folder name, then the Choose button.

(21 ] =————Please select alearner's folder.

| 5§ My Stages Reports B a E

Spy . Y 0-» oo [
1 My Stages Reports % Date Modified |2

3 ., Sample Learner Yesterday

=1
La

Sample Learner

D]

|
Cancel @] [(NewD ] [ _open || [ cancel | | CI’II::ISE ]

4

The learner whose folder you select will be added to your Learner
List. You can also use this button to restore a learner that you
removed from the Learner List.

If you choose a folder for a learner who has never been set up in
Stages Report Wizard, you will be prompted to go to the main screen
and choose the Add a New Learner button.

Assistive Technology, Inc.
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3. Your Learner Reports

Adding Learners

When you are ready to use Stages Report Wizard with reports for
your own learners, gather the Stages reports you have previously
saved and follow these steps. The result will be a set of learner folders
within your ‘My Stages Reports’ folder, as shown on the next page.

- dd New 1. At the main screen of Stages Report Wizard, click the Add New
L Learner button. A window will open so you can enter the learner’s
first and last names.

Add a Learner

Please type the learner's name.

First Name: ‘Jane |

Last Name: ‘ Doe| |

Clicking Set Up Learner creates a folder for that learner. Click the
Cancel button if you choose not to proceed.

Inside the new learner’s folder will be an empty Activity
Summaries folder, an empty Annotated Reports folder, and the
learner’s Profile file, which includes just his or her name. You can
add more information to the Profile by clicking the Edit Learner
Profile button on the main screen.

2. After you have created folders for one or more learners, exit
Stages Report Wizard by clicking the Quit button or choosing
“Quit” from the File menu.

3. At the Desktop, copy or move each learner’s report files into his or

If you wish to her new folder. When you restart Stages Report Wizard, it will
learn more find your learners’ folders and report files.
about the
f‘;!;’leri har;d You can also create folders for your learners before you launch Stages
1les tha

Report Wizard. Be sure to put the folders in the My Stages Reports’
Bizard used) folder. The next time you start up Stages Report Wizard, it will create
please refer to the Activity Summaries and Annotated Reports folders and Profile
Appendix A. file in the folder for each new learner it finds.

Stages Report

page 8 Stages Report Wizard User Guide



Organizing Your Learners’ Reports Folders

Use this example file “tree” diagram as a model for how to set up
your report folders. Follow these simple DOs and DON'Ts as you put
learner’s reports into folders.

>

DON’T mix reports for different
learners in the same folder.

DO put all reports for the same
learner in the same folder in the
‘My Stages Reports’ folder.

DO mix reports for different
Stages for the same learner in the
same folder, if you like.

DO have subfolders, if you like,
for different Stages (as in Jane
Doe’s folder in Figure 1) or
different types of activities
within a learner’s folder (as in
James Smith'’s folder in Figure 1).
Stages Report Wizard can locate
the reports if they are in the
learner’s folder (not in a
subfolder) or in subfolders
within the learner’s folder. It
won’t find reports if they are in
subfolders inside the subfolders,
however. In Figure 2, Stages
Report Wizard will find the
reports both in the learner’s folder

and in the “‘Money activities’ folder.

DO put Annotated Reports you save
in the Annotated Reports folder. Put
the Activity Summaries you save in
the Activity Summaries folder. Stages

Report Wizard will automatically

direct you to these folders when you

save these files.

DO, before you begin using Stages Report

=1 My Stages Repors

=21 James Smith
--I:I Activity Summaries
--D Annotated Feports
1 Money activities
=-1 Jane Doe
--I:I Activity Summaries
--D Annotated Feports
--I:I Stage b
m-1 Stage 7
IZ—II{:I John Doe
-0 Activity Summaries
--I:I Annotated Reports
&1 Stage 1
w1 Stage 2
ED Sample Learner
--I:I Activity Summaries
&1 Annotated Reports
--I:I Stage 1
--D Stage 2
--I:I Stage 3
&[] Stage 4
--I:I Stage &
--D Stage B
m=-1 Stage 7

Figure 1

[ bMoney activities

[ Activity Summaries
[ Annotated Reports
JSrniith.revd
JSrniith.rep

2] 6 Getting Dressed 2.t
2] 6 Rec Signs 1.4

b FecSigns 2.0d

b Using Objects 1.t

Fiqure 2

Wizard (and periodically), make a backup copy of your report
folders. Individual reports are very small in size and all reports
will probably fit easily on a floppy disk. You can also copy reports
to a removable volume, a networked computer, or a CD.

Assistive Technology, Inc.
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Learner Profiles

Click the Edit Learner Profile button to go to the Learner Profile
screen. Here you can enter as much information as you would like
about the learner. The only required information is the learner’s first
and last names. This information will be automatically loaded
whenever you start up Stages Report Wizard and choose this learner
and will be included in Activity Summaries and Annotated Reports.

Learner Profile Today'sDate. Wed, Ssp 17, 2003
First Name: ‘Sample ‘ Last Name: ‘Learner ‘
Use the CurentSmgesy (01 O 2 O3 O4 O5 O6 O7
Learner School/Fadility: | Central School Teacher/ | Stuart Miller Save school information
as standard data
Profile to Address: [100 Main st. Evaluator(s)
e
store 1 -
Bt t State/Province: [US |  ZIP/Postal Code: | 12345-6789 1) | Inatructor
R ormatie Phone; | 123-555-1234
that will
. Other Learner Information (names of additional team members, access/positioning notes, and other general comments about this learner)
remain the ‘ :
Sample Learner is working on colers next (Stage Four).
same for

every activity.

cear o S
<2 ) continue £

After entering the learner’s Profile data, you can print this screen by
clicking the Print button or choosing “Print” from the File menu.

After you have entered the learner’s profile information, click the
Save and Continue button. If you wish to leave this screen without
saving any information, click the Cancel button.

If you wish to start over with a blank form, click the Clear button or
choose “Clear” from the Edit menu. Either method erases all data
from the screen.

Save school information]  1f most of your learners share the same school information, you can
[ as standard data ] click the Save school information as standard data button to store it.

[ Fill in standard data ] When you add a new learner and need to enter the same school
information, simply click the Fill in standard data button, and the
same information will automatically be added.

To change the standard data, edit the data on this screen and click the
Save school information as standard data button. Later, click the Fill
in standard data button to enter the revised data for future learners.

page 10 Stages Report Wizard User Guide



4. Choosing Reports

Selecting the Activity

Select the Stage for the learner. Stages Report Wizard will

automatically detect the Stages of the learner’s files.

3%

@d Learner

Stages Report Wizard

Learner Name: Sample Learner

Select the desired Stage by clicking a radio button below.

@ © Stage One

© Stage Two

© Stage Three <

Tips

i © Stage Four
W © Stage Five
@ O stage Six

© Stage Seven

The buttons for Stages for which no reports were found will be

dimmed.

Click to
choose the
Stage.

If the learner has reports for just one Stage, Stages Report Wizard will
go directly to the activity choices for that Stage, skipping this screen.

After you select a Stage, you will be able to choose the activity at that

Stage.

You can return to this screen by selecting “Choose a New Stage” from
the File menu.

Assistive Technology, Inc.

page 11



At the next screen, click the button for the activity you wish to use.

Stage Four Reports

Tips

Select the Activity to use to view and graph reports.

Colors Shapes Math Readiness Reading Readiness
® Color ID © Shape ID © Number ID @ Letter ID
© Counting O Letter Sounds

O Assess Spatial
O Assess Fstimate
© Assess Patterns

O Create Patterns

@a Stage Choose @

At Stages One, Two and Three, you can select an activity attribute to
further refine your file selection.

At Stage One (shown below), you can select the Prompt type. It may
be critical for your results to compare the learner’s performance using
the same type of Prompt method.

@ Stage One Reports
1ps

If there are no Select the Activity to use to view and graph reports.

reports for this ® press and Hold

learner for an
activity, its
button will be

dimmed. Choose the Prompt type for these reports.
(Because of the nature of these activities, it may be critical to
compare reports in which the learner uses the same prompt type.)

© Press and Release

® Any
O Multisensory
2 Visual

@a Stage Choose @

page 12 Stages Report Wizard User Guide



At Stage Two, you can choose reports based on Level of
Representation.

Stage Two Reports

Tips

Select the Activity to use to view and graph reports.
< Nouns
< Verbs
® Attributes

Choose the Level of Representation for these reports.
(Because of the nature of these activities, it is critical to compare reports
in which the learner uses the same level of representation.}

© Photo

® Drawing

© Symbol

@ a Stage Choose w

At Stage Three, you can choose reports based on Category (except for
the Level of Representation activity). Choose the Any button to
include all reports of any type for that activity.

Stage Three Reports

Tips

Select the Activity to use to view and graph reports.
© Level of Representation
© Object ID
O category ID
® Function ID

Select a Category for the activities in these reports.
(You may wish to compare reports in which the learner uses the same category.)

O Any
O Toys
© Clothing
® Vehicles

@ a Stage Choose w

Assistive Technology, Inc. page 13



Some activities at later Stages, such as the Computation activities at
Stage Five (shown below), have an additional choice to make, such as
whether you want to use Add & Subtract, or Multiply & Divide
activity data.

Stage Five Reports
ps

Select the Activity to use to view and graph reports.

Reading Math Problem Solving
® |etters - Alphabetize O Charts and Graphs O Number Guess
O sSounds - Rhyming O computation - Math Facts O scrambled Words
O Meaning - Dolch Words O computation - Word Problems O Mmaking Words
O context - High Frequency O Geometry O Tic Tac Toe
© Fractions O Mystery Games

Choose the specific activity.

® Beginning - One Letter

O Advanced - Two Letter

@a Stage Choose

After selecting an activity, and in some cases the specific activity
within that set, click the Choose Reports button to continue.

page 14 Stages Report Wizard User Guide



Creating a Report Set

Annotate One

Learner Report
" lcomment, save, print)

. rwl

During a Stages
assessment, if
you choose to
skip out of an

activity, it is
marked
“Incomplete”
by Stages
Report Wizard.

Stages Report Wizard will now display the name, date, and input
method used for each learner’s report file for the activity you chose.
Any unfinished activities are identified by the word “Incomplete” in
the column before the report name.

Sample Learner
Stage One:
Press and Hold

Tips

Choose Reports

To graph. a report set must contain from 2 to 10 reports.
You can also preview a report, annotate it with
your comments, and save or print it.

save data for
one report, with
your comments

Annotate One
Learner Report
_ (comment, save, print)

Click on a report name to select it. Use Ctrl or Shift to

Learner Reports select multiple reports, then click the Add button,

Aug 15, 2003 Switch  Sample P&H 1 Vis.Etxt
Incomplete Oct 14, 2003 Switch Sample P&HE 2 Mult.txt Add all
Oct 18, 2003 Switch Sample P&E 2 Vis.txt reports
Dec 17, 2003 Mouse Sample P&E 4 Mult.txt
Feb 26, 2004 Mouse Sample P&E 5 Mult.txt
Apr 25, 2004 Mouse Sample P&E & Mult.txt
Add selected
reports to set '\
~
add selected
- . (=53, Add reports by r Ort tO ra h
Include in Activity Summary: (o] ) input metnog eports to grap
Aug 15, 2003 Switch Sample P&E 1 Vis.txt
Oct 18, 2003 BSwitch Sample P&E 2 Vis.txt from the upper
Dec 17, 2003 Mouse Sample P&H 4 Mult.txt .
Feb 26, 2004 lMouse Sample PSH 5 Mult.txt Aﬁ:&ﬂ'z;ﬁﬁf list
Apr 25, 2004 Mouse Sample P&H 6 Mult.txt
ﬁkemwe
all reports

@an Activity To@

At this screen you will select reports to work with from the upper list.
Note that only Assess activities are listed; Explore activities aren’t
available for analysis by Stages Report Wizard.

Click the Annotate One Learner Report button if you wish to view an
individual report before including it. You can also add comments and
save or print this Annotated Report (see next page). This is
particularly useful for documenting valuable information about
sessions marked as Incomplete, as you cannot create graphs or tables
using these reports.

To create graphs, you need from 2 to 10 reports for completed
activities.

To create a Content Mastery table, you need at least one completed
activity.

To graph reports or create Content Mastery tables, select reports
individually from the top list and add them to the box at the bottom
of the screen. Note that you cannot add reports marked as
Incomplete.

Assistive Technology, Inc.
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There are several ways to add one or more reports at a time. You can:

¢ double-click a report name;
e click a report name to select it, then click the Add button;

\F <4— ¢ hold down Ctrl and click multiple report names, then click the

F \ Add button;

‘x‘+’,:’ ¢ hold down Shift and select a range of report names, then click
A \ the Add button;

e click the Add all reports button to add all completed reports;
e click the Add reports by input method (see below)

s ) To remove an activity report from the list at the bottom of the screen,
click a report name to select it, then click the Remove button. Or, click
the Remove all reports button to move the entire group of activity

f N reports.
y— 3 p

If you choose more than 10 reports, you will be prompted to remove
some.

- ‘h Add reports by You can also narrow down the number of reports by selecting those

E input method activities completed using the same input method. Click the Add
reports by input method button to choose reports for activities
completed using the same input method. It may be important to
compare reports in which the learner used the same access method,
particularly if the learner does much better using one over another.
Clicking this button will take you to a screen where you can choose an
input method. When you return to this screen, only reports in which
that input method was used will be listed in the lower box.

If you see a message that no reports were found and you are sure that
you have some, click the Choose an Activity arrow and double-check
the activity and the Stage number you have selected. Note that only
the reports for Assess activities are included.

When you have selected the desired reports and they appear in the
lower box, click the To Tables and Graphs button at the bottom right
of the screen. (At Stages One and Two, where Content Mastery tables
aren’t available, this button is labeled To Graphs.)

page 16 Stages Report Wizard User Guide



5. Annotating and Printing an Individual Report

Creating an Annotated Report

Annotate One

= Learner Report
=1 {comment, save, print)

If you select a report and click the Annotate One Learner Report
button at the “Choose Reports” screen, you will go to a screen with
the report data and a comments box.

Type any comments you wish to make in the comments box at the
bottom of the screen.

.
Report File Name: Sample Math_Coun 2.txt Tins preview

Stage Four L . t t f

Date: Now 0Z, 2003 Time: Z:44 PM _ ( prln Ou O

[F review annotated report

Learner's Hame: Sauple Learner

Activity: Aszess Counting — .

Toput Hethod: e ! Lo min <— print annotated

Fremquency of Proupt: 5 zeconds .~y annotated

Proupt Type: Multisensory t‘«’ﬁ"m" report

Create .
one tries: correct: Yes prompt: @ PDF File ' Ccreate PDF flle

two tries: correct: Yas prompe:

three tries: correct: Yes prompt:
correct: Yes prompe:
correct: Yes prompt:
correct: Yes prompe:
correct: Yes prompt:
correct: Yes prompe:
correct: Yes prompt:

four tries:
five tries:

= g savean
report
" annotated report

six tries:
seven tries:
eight tries:
nine tries:

00w W W W W e
coorooOROODO

ten tries: correct: Yes prompt: ‘~ Open SaVed
Number of Prompts: Open a different tat d t
. d report annotated repor
Add notes for this I'EDOHZ You may wish to review your Observation Forms for this session
Sample Learner has no problem with counting to mmbers 1 through 3.
B sure 1o prirt and
4 Tove BeTore eav g add notes

this screen.

At this screen, you can print an Annotated Report, which includes the
report data, your notes, and the learner’s Profile information.

Click the Preview button to view the report before printing. While the
preview is showing, click on it to flip through the pages.

The first time Click the Print annotated report button to print the report.
you start to (Macintosh users: If you have just created a PDF file, remember to go to
create a PDF the Chooser and select your standard printer.)
file, Stages
Report Wizard Click the Create PDF file button to save the document as an electronic
will ask if you PDF (Portable Document Format) file. You can then open the PDF file
WISII: to instay on either a Macintosh or Windows computer to view it contents, save
stofiv{r,zl: it in your learner’s folder, print it to include in a portfolio, or e-mail it

to colleagues. See Appendix B for details about the PDF software.
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Macintosh Users: Be sure to select the PrintToPDF printer in the
Chooser before clicking the Create PDF file button.
After creating the PDF, remember to return to the
Chooser to select your standard printer.

Windows Users:  After clicking the Create PDF file button, select the
PDF995 printer in the drop-down menu of the print
dialog box.

You will be asked to enter a filename and choose a location to save the
PDF file. To open the file, you will need Adobe Reader, which you
can install from the Stages Report Wizard CD (see Appendix B).

Click the Save this annotated report button to store the information
on this screen. The Annotated Report is saved in the learner’s
Annotated Reports folder, under a name you choose. Do not change
the .rw1 extension that is assigned to this type of file.

If you wish to view or print the Annotated Report at a later time, click
the Open a different annotated report button at this screen or the
Open Saved Summaries button at the main screen. (You can get to
the main screen at any time by selecting “Choose a Different Learner”
from the File menu.)

Considering Incomplete Reports

Even though Stages Report Wizard does not include data from
incomplete activities in graphs or tables, information about those

Use an activity sessions might still prove valuable to consider and include
Annotated when reporting on learner progress. Use an Annotated Report to
Report to interpret this data in the Notes box. Indicate why the activity might
jinment on iy not have been completed and record next steps to take with this
fcomplely learner and the assessment process.
activity. P
Although these ) ) )
[ivities can’t B These are some examples of questions to consider when making
graphed, they comments in the Annotated Report for an incomplete activity:
can still provide . .
valuable ¢ Did the learner understand the activity?
information. ® Was the access method working effectively?
¢ Is the learner feeling well?
¢ Are medications properly administered?
¢ Are there issues in the learner’s home environment to
consider?
¢ Was the environment distracting or uncomfortable?
e Were there any disruptions during the assessment?
¢ What steps might be taken to achieve better results during
the next session?
page 18 Stages Report Wizard User Guide



6. Graphs

Graphs show a
picture of
overall
accuracy and
independence.

accuracy

[Show Line Graph ||

Goal:

After selecting the reports, click the arrow at the lower right of the
screen to see the graphs for this report set. Depending on the activity
you have selected, the label on this arrow may be To Tables and
Graphs, To Graphs, or To Tables.

When you go to the graphing section, Stages Report Wizard will
automatically generate all the available line and bar graphs for this
activity. As each graph is created, its image is saved in memory so
that you can include it in the Activity Summary, if desired.

The graphs show the learner’s progress in the areas of Accuracy,
Independence and Time on the activity. This key data is critical to
showing overall achievement. Data about specific knowledge is
presented in the Content Mastery tables (see the next section).

The graphs that are available depend on the Stage —and in some
cases, the specific activity —and are described below. The button with
the white background shows which graph is currently displayed.
Click any button to view one of the other available graphs.

If you are viewing a bar graph and wish to view a line graph, click the
Show Line Graph button. The button will change to read Show Bar
Graph when you are viewing a line graph.

For Accuracy and Tries graphs, you can add a goal line to show what
the learner is striving to achieve. To set a goal, enter a value in the
goal box, replacing the word None. Click the Show Goal button to see
the line. For Accuracy graphs, enter a percent, a value from 0 to 100.
For Tries graphs, enter a value from 1 to 3.

In the example below, the Accuracy goal has been set to 80%.

100 %

80%

40 %

Assistive Technology, Inc.
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Copy and paste
text between
Stages Report

Wizard and
other
applications.

Windows: use
Ctrl-C to copy,
Ctrl-V to paste.
Macintosh: use

You can also choose whether or not to display the gray arrow. The
arrow shows the ideal direction for improvement. It points up for
Accuracy graphs and down for Tries and Prompts graphs, giving you
an immediate visual guide to learner progress. It does not appear for
Time graphs because this data can be interpreted in different ways
based on the learner and the activity. See page 27 for a further
discussion of time data.

To hide the arrow, click the Hide Arrow button. To show it again, click
the Show Arrow button, which replaces it.

At the upper right of the screen, shown below, is a table that displays
the dates and values that are plotted in the graphs. Under Session
Date is a list of the dates, in the order they are graphed. If more than
one session occurs on the same day, the time is listed as well. At the
right are the values that are graphed. These values change when you
switch to a different graph type.

Date Range: Sep 02, 2002 - Jan 02, 2003

Data
Session Date values - Imput/Prompt

Sep 0Z Z0.0 - 1
How 02 0.0 - M
Jan 0Z 0.0 - M

Keyto Input Method Abbreviations
M= Mouse S= Switch

T = Touchscreen K= Keyboard
P = Alternative Pointer

Following the data values is a letter code for the input method used.
The legend below the table indicates the input method each letter
stands for. At Stages 1-3, this letter is followed by the prompt type
used: Multi for Multisensory, Audit for Auditory, or Visual.

Use the Comments box at the lower right of each screen to enter notes
about the graph or the learner’s performance that may not be
apparent from the data. Refer to your Observation Forms for any
relevant information. You may wish to compose your comments in
another application, such as a word processing program, where you
can see the entire text at once. This also gives you an opportunity to
check for spelling and grammar before including it in Stages Report
Wizard. In the other application, copy the text. Then click on the
Comments box in Stages Report Wizard and press Ctrl-V (Windows)

LIS or &V (Macintosh) to paste your text there. You can also copy text
38V to paste. . . . .
you type in Stages Report Wizard by pressing Ctrl-C (Windows) or
#C (Macintosh) and paste it into another application.
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As you switch from graph to graph, each image is being automatically
captured for inclusion in the Activity Summary. The most recent
image displayed for each graph type will be used. Therefore, if you
choose to add a goal line or remove the arrow, click the buttons to
view all graphs, including line and bar graphs, in order for your goal
lines and arrows to appear as you want them in the Activity
Summary.

When you are done viewing graphs, click the button labeled Go to
Table for activities in Stages 3-7 that generate Content Mastery tables.
Otherwise, the button is labeled Go to Summary and clicking it allows
you to proceed to create an Activity Summary.

Accuracy Graphs

An Accuracy graph shows how well the learner understood the
overall concept of the activity. It does not show mastery of specific
content. (See the section that follows about Content Mastery tables for
this information.)

Accuracy is defined in different ways, depending on the Stage. In
general, the graph for Accuracy depicts how well the learner is
moving toward the goal of the activity.

Stage 1: In Press & Hold activities, a low number of presses indicates
that the learner has a better understanding of cause and
effect and can control the input device. The goal is to have
one long press for each activity. The data represents the
average total presses and average longest press for each
activity saved in one report.

Accuracy graphs for Press & Hold activities:
Average total number of presses
Average longest press
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Learner: Sample Learner
Stage One: Press and Hold Date Range: Aug 15, 2003 - Apr 25, 2004
Accuracy -- Number of Presses ) Data )
Session Date values - Input/ Prompt
1 Bug 15 10.0 - § / Visual
Gt 18 5.5 - § / Visual
o Dec 17 3.7 - M/ Malti
Feb 26 3.0 - M/ Malbi
& Bpr 25 2.0 - M / Malki
g
4
5 7
&
k-]
g 6
2
E
=
=4 5
g Keyto Input Method Abbreviations
Il M= Mouse S= Swilch
g 4 T = Touchscreen K= Keyboard
= P = Alternative Pointer
3
Presses: The average number of longest press
2 learner device activations for an
1
0 =
=) 9 =) pod 2 ShowLine Graph |~
=] = =] = =] Presses Graph comments
& = & = &
1) 0 ~ o 1]
= 2 = & 4
o b o -] =
2 8 8 s 2
Assessment Dates Go to m

In Press & Release activities, the learner should also have a
low number of presses. The goal is for the learner to enter
the same number of presses as the number of required
presses for each activity. Therefore, the data that is graphed
compares the average number of presses for each activity to
the required number of presses.

Accuracy graph for Press & Release activities:
Average total number of presses vs.
number of required presses

Learner: Sample Learner
Stage One: Press and Release Date Range: Aug 26, 2003 - Jul 26, 2004
Accuracy -- Number of Presses Data )
Session Date values - Input/Prompt
s Bug 26 11,5 - M 7 Maltl
Oct 15 10.2 - M / Budit
Dec 16 7.7 - M/ Visual
Mar 10 §.7 - M / visual
“ 0 May 23 5.0 - M/ Maltl
5 Jun 16 6.8 - M / Maltl
& Jul 26 6.0 - M/ Budit
-
=}
g 15
2
£
=2
=
g Keylo Input Method Abbreviations
Il M= Mouse S= Switch
¥ 10 T = Touchscreen K= Keyboard
= P = Alternative Pointer
The gray line indicates the
. Presses: The average number of
requlred number Of 5 learner device activations for an
activity. The gray line with boxes is
presses fOI‘ Stage One the goal. It shows the average
. number of device activations
Press & Release aCtIVltleS. required to complete that activity.
0
a a a 2 s 2 s Show Line Graph |~
=1 =1 o o o o o Presses Graph comments
& & & & S & S
o Il o o o "3 3
g = 2 = b 2 &
08 5 & 2 5 3
Assessment Dates Go mm
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Stage 2:

The gray line indicates
the required number of
presses for Stage Two
activities.

Stage One Press & Release graphs display a gray line
that indicates the number of presses that were required
to complete the activity. You can compare the number
of presses the learner made to these values to
determine how close they are to the target goal.
Optimally, the number of learner presses should match
the number of required presses.

Note that the number of required presses may not be a
straight horizontal line if the same number of parts of
the activity weren’t completed for every report. For
example, on one day the learner may do two Press &
Release activities, which are saved in the same report,
and on another day, do all six activities in a row.

In Stage 2, the learner should also have a low number
of presses. The goal is for the learner to enter the same
number of presses as the number of required presses
for each activity. Therefore, the data that is graphed
compares the average number of presses for each
activity to the required number of presses.

Accuracy graph for Stage Two activities:
Average total number of presses vs.
number of required presses

Average Number of Presses

. Learner: Sample Learner
Stage Two: Drawing - Verbs Date Range: Sep 31, 2003 - Apr 01, 2004
Accuracy -- Number of Presses Data ;

Session Date values - Input/Prompt
Sep 31 14.0 - M/ Hulti
Mar 31 5.0 - M/ Multi
Apr 01 3.8 - M/ Hulti
Keyto Input Method Abbreviations
M= Mouse S= Switch

T = Touchscreen K= Keyboard
P = Alternalive Painter

Presses: The average number of
learner device activations for an
activity. The gray line with boxes is
the goal. It shows the average
number of device activations
required to complete that activity.

Show Line Graph |~
Presses Graph comments:

Sep 31,2003
War 31, 2004
Apr 01, 2004

Assessment Dates Go lom

Stage Two graphs display a gray line that indicates the
number of presses that were required to complete the
activity. You can compare the number of presses the

Assistive Technology, Inc.
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Stages 3-7:

learner made to these values to determine how close

they are to the target goal. Optimally, the number of

learner presses should match the number of required
presses.

In the remaining Stages, the learner is asked to make a
choice to select the correct target, based on the
question. In many activities, incorrect answers are
removed, making it more likely that the learner will
choose the correct answer. To eliminate the possibility
of a learner ultimately choosing the correct answer by
chance or because it was the only remaining choice,
Stages Report Wizard defines a correct answer as one
that is chosen on the first try. A different graph shows
the number of tries, so that data is also available.

% of questions answered correctly on first try

Average % Correct on First Try

Learner: Sample Learner

Stage Four: Assess Counting Date Range: Sep 12, 2003 - Apr 02, 2004
Data
o ACCU'{EC)’ Session Date values - Input/Prompt
100 % Sep 12 0.0 - M
Now 02 30.0 - M
0% Jan 02 30.0 - M
Bpr 02 80.0 - M
80 %
70 %
60 %
50 %
Keyto Input Method Abbreviations  gpal: [None
M= Mouse S= Swilch
40 % T = Touchscreen K= Keyboard
P = Alternative Pointer
30 %
Accuracy % correct): Percent
20 % accuracy is the ratio of the number m
of questions answered correctly on —
. the first try to the total number of
10 % questions in the activity. The large m
arrow, if present, shows the ideal
a direction of improvement.
Show Line Graph |~

Accuracy Graph comments:

Sep 12,2003
Nov 02, 2003
Jan 02, 2004
Apr02,2004

Assessment Dates Go to

6
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Independence Graphs

There are two types of Independence graphs in most Stages. One
indicator of increased independence is a reduced number of prompts
required for the learner to complete the task. In early Stages (1-4),
Independence graphs for the average number of prompts required
during the session are generated.

Another indicator of independence is the number of tries required to
answer the question, regardless of whether the question was
ultimately answered correctly or incorrectly. In later Stages (3-6 and
some activities in 7), the number of tries is tracked and can be

graphed.

The fewer prompts and tries required to complete the activity, the
more independent the learner is.

Average Number of Tries

. Learner: Sample Learner
Stage Four: Assess Counting Date Range: Sep 12, 2003 - Apr 02, 2004

Independence -- Number of Tries s bata ,
ession Date values - Input/Prompt

Sep 12 Z.7 - M

Now 02 2.4 - M

Jan 02 Z.0 - M

apr 0z .z - ™

Keyto Input Method Abbreviations .

M= Mouse 5= Swilch Goal:
T= Touchscreen K= Keyboard
P = Alternative Poinler
Tries (independence): The average
number of tries (total overall tries m
divided by the total number of —

questions answered). The large
arrow, if present, shows the ideal
direction of improvement.

Show Line Graph |~

Tries Graph comments:

Now 02, 2003

Sep 12,2003
Jan 02, 2004
Apr0z, 2004

Assessment Dates Goto m»

The following graphs are generated for Independence in the seven

Stages:

Stages 1-2:

Stages 3-4:

Stages 5-7:

Independence —average number of prompts

Independence —average number of prompts
Independence —average number of tries

Independence —average number of tries

Assistive Technology, Inc.

page 25



At Stage Three, the Level of Representation activity displays separate
bars or lines for the three different levels of representation. This
allows you to compare learner performance with respect to each type.

3

Legend
I Fhotographs

Drawings

1 | | | H Symbols

Stage Five has special graph types for the Making Words activity
(creating words using the letters from the word STRIPE). The graphs
indicate the learner’s average number of words and the average word
length. Keep in mind that the two measures should be combined to
judge the learner’s accomplishment. For example, a high average
word length may offset a low word count.

The Stage Seven open-ended activities, which have no right or wrong
answers (i.e., Building Sentences, Writing Sentences, and Making
Stories), are not graphed. Instead, Content Mastery tables show the
learner’s achievement.
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Time on Activity Graphs

Should Time
increase or
decrease over
time? It
depends on the
learner, the
activity, and
the situation.

A final indicator is the length of time a learner took to complete the
activity. Note that there is not a “right” or “wrong” amount of time.
Therefore, there is no arrow on this graph to indicate the ideal
direction of improvement.

If a learner spends more and more time on an activity, it may be
because she finally understands the content and needs to take time to
think and process her answer. In other cases, taking longer to
complete an activity may indicate that the learner was distracted,
requiring many prompts, or getting many answers incorrect.

If a learner takes less time to complete an activity, it could also mean
several things. For example, he could understand the content well
enough to complete the activity accurately in less time. However, it
could also mean that random clicking or guessing, combined with the
Stages feedback of successive approximation, allowed him to
complete the activity quickly.

. Learner: Sample Learner
Stage Four: Assess Counting Date Range: Sep 12, 2003 - Apr 02, 2004

i Data
Time Session Date values - Input/Prompt

Sep 12 3:37 - M

Now 02 2:36 - M
4:30

Jan 02 1:58 - M

Bpr 02 2:10 - M
4.00

230

200

2:30
Keyto Input Method Abbreviations
M= Mouse S= Swilch
2:00 T = Touchscreen K= Keyboard
P = Alternative Pointer
13
Time: The average time to complete
101 the activity. A learner's m
improvement could be represented =
by either an increase or a decrease
03 depending on the learner's m
objectives for that activity.

Show Line Graph |~
Time Graph comments.

Minutes:Seconds

=3 1=

&

Sep 12,2003
Nov 02, 2003
Jan 02, 2004
Apr02,2004

Assessment Dates Go tom

In either case, you will need to refer to your Observation Forms to
learn what the time on activity value truly means. Use the Comments
box for the graph to include your interpretation of the learner’s
performance in the Activity Summary.

Assistive Technology, Inc.
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Images of Graphs

Choose “Copy screen image” from the Edit menu if you wish to place
a copy of the screen on your computer’s Clipboard. This allows you to
switch to a different application and use the “Paste” command from
its Edit menu to place the image there. This may be a convenient way
to create assessment reports using your local district’s forms.

Only the text in the scrolling Comments box that is visible on the
screen will be captured. To copy the entire text, select all the text in
the Comments box, then press Ctrl-C (Windows) or 3C (Macintosh).
In the other application, choose “Paste” from its Edit menu to place a
copy of the full text there.

page 28 Stages Report Wizard User Guide



7. Content Mastery Tables

Content Mastery
tables help you
choose
appropriate
curriculum
software to help
your learner
build needed
skills.

Content Mastery tables are available for Stages 3-7, as those Stages
contain activities that are curriculum-based in nature. You can learn
from these tables what specific content the learners have mastered,
and where they need more practice.

In most Content Mastery tables, the question labels or descriptions are
listed in the left column. There are three columns with percents that
indicate whether the learner got the correct answer on the first
attempt. Because so many of the activities are designed to provide
instructional feedback when the learner gives an incorrect response,
they use a strategy known as successive approximation, or removal of
one or more incorrect answers after a wrong response. Therefore, the
most valid way to show mastery of the content is if the learner gets
the correct answer at the first attempt.

The column labeled “First” shows content mastery for the first session
of the set. The column labeled “Final” shows content mastery in the
last session of the set. The column labeled “Average” shows the
average of all sessions for each content item. For the First and Final
columns, the percent will be either 100% (the learner got the answer
correct on the first try) or 0% (the learner got the answer wrong on the
first try). The percent values in the Average column will vary, as the
averages for all sessions are computed.

If you are viewing a Content Mastery table for just one session, all
three columns will show the same values, as the First and Final

sessions are the same session, and the average is also the same.

% Correct on First Try for First, Final, and Average of All Sessions

Content First Final Average
ane 100% 100% 100%
twn 100% 100% 100%
three 0% 100% 67 %
four 0% 100% BT%
fiwe 0% 100% G7%
Si 0% 100% 33%
SEVEN 0% 100% 33%
eight 0% 100% 33%
nine 0% 100% 33%
ten 0% 100% 33%

Shown above is the Content Mastery table for the Stage 4 Counting
Assess activity in the Math Readiness section. From this table, you can
identify which specific numbers the learner has mastered and which
require more practice.

Assistive Technology, Inc.
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The Content Mastery tables for some of the Stage Seven activities
allow for additional scores or marks. For example, in the Building
Sentences activity (shown below), you can enter a “Y” or ‘N’ or other
mark in the columns at the right. These columns, labeled S, G, and P,
represent Sentence Structure, Grammar and Punctuation. This
information is saved for inclusion in the Activity Summary printout
and saved file.

- H 1 T ¥ oar N i h
Stage Seven: Building Sentences T o
to showe if the leamer used:

8: complete Sentences

Date Range: Sep 16, 2003 — Jun 21, 2004 ] E: ::r'r':;‘su'igrj"m

Date Learner Text # words Gr.1 Gr.2 Gr.3 S G P
Nov21,2003  Dad gives the dog a drink 6 5 1 v oy Nl
Jan18,2004  The litle man walks to the pretty house. The dog drinks water, Goad huy. 14 5 2 2 o
Jun 21,2004  Dad and Mom carry the little cat to drink the clean water. 12 7 4 _

2 Grade 1 © Grade 2 ® Grade3

You can add comments to any Content Mastery table and include
them in the Activity Summary for the current set of activities.

Choose “Copy Screen Image” from the Edit menu if you wish to
capture the Content Mastery table for use in another application. If
the table is a scrolling text box, only the visible text will be captured.
The complete text, however, will be included in the Activity
Summary.
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8. Activity Summaries

After viewing and customizing your graphs and tables, you will go to
the Create an Activity Summary screen. Here you can choose what
you want to include in an Activity Summary.

The Activity Summary is created for the current activity. It compiles
all the graphs, Content Mastery table, your comments and the
learner’s Profile data into one comprehensive document. You can
preview the Activity Summary, print it to a printer attached to your
computer, create a PDF (Portable Document Format) file, and store it

for future edits or distribution.

Sample Learner
Stage One:
Press and Hold

Preview
,  selected item,
then click to hide it.

Select items in

Available Summary Items
the left panel [ate created 9/17/03 (header)
. [Date printed 9/17/03 (footer)
and place into oamnis Profile snfarmation
n otes and Recommendations R
Longest Press bar graph
the right panel pongest Pruss b

[Frompt bar graph
[Cime bar graph

ames of report files
[Prepared by

in the order
you want them
to appear in the
Activity
Summary.

[ Include bar graphs in lisk
[ Include line graphs in lisk

0>

Add all

>

Add

<]

Remove

<

Remove all

Create an Activity Summary

Select items you want to include in your Activity Summary
Double-click items or use the arrow buttons below to add or remove selected items.

Enter Notes and
Recommendations

Order of Items in Activity Summary

[Learner Frofile information

To change the ordsr of this list, select an
itern and Use the up and down srrow keys

@ Return to Graphs

E{\ Preview this Summary

ry
]

Q‘\/\{ Print this Summary
@ Save this Summary

(= Store this Summary
I toRecreate Later

Tips

Recreate a
Stored Summary

Be sursto print and
save before leaving
this screen

For the Stage 4 - Counting activity, for example, you can choose to
include the following data in your Activity Summary.

Date created (header)
Date printed (footer)
Learner Profile information
Notes and Recommendations
Accuracy line graph
Accuracy bar graph
Comments about Accuracy
Prompt line graph

Prompt bar graph

Comments about Prompts

Tries line graph

Tries bar graph
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Comments about Tries

Time line graph

Time bar graph

Comments about Time

Content Mastery table

Content Mastery comments

Names of report files

Prepared by (a signature line for the preparer)

Comments will appear in the list only if you added comments to the
graphs and or table.

Initially, the list will show just bar graphs, not line graph. Use the
check boxes below the left panel to list one or both types of graphs.

[ Include bar graphs in list
[] Include line graphs in list

Customize your Activity Summary by selecting items to include from
the list on the left. There are several ways to add one or more items at
a time. You can:

e double-click an item;

D>« «dickthe Add all button to add all items

Add all

e click an item to select it, then click the Add button;

9 44//// ¢ hold down Ctrl and click multiple items, then click the Add

button;

Add q\
¢ hold down Shift and select a range of items, then click the Add

Remove ‘\

<Y

Remove all

\ Preview
selected item,
then click to hide it.

Enter Notes and
Recommendations
P

button

To remove an item from the list at the right, click an item to select it,
then click the Remove button. Or, click the Remove all button to
move the entire list of items.

You may wish to preview an item to see what information it contains
before adding it to the Activity Summary. To preview an item, click
its name in the left panel, then click the Preview button above. After
previewing the item, click anywhere on the screen to hide it.

If you preview the Learner Profile information and find that it needs
to be updated, click the Edit Learner Profile button to make changes.
The revised information will be included in the Activity Summary.

You may also wish to enter information in the Notes and
Recommendations section before creating the Activity Summary. For
more information, see the section that follows, on page 34.
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The list at the right, which contains the items you have added, shows
the order in which they will appear in the Activity Summary. If you
wish to change the order of the items that have been placed, select an
item you wish to move and use the up and down arrows on the
keyboard to move it within the list.

After you have selected and added the items that you wish to include,
click the Preview this Summary button to view the report or click the
Print this Summary button to print it to the printer attached to your
computer. (Macintosh users: After creating a PDF file, remember to go
to the Chooser and select your standard printer.)

Click the Store this Summary to Recreate Later button to save the
contents of the Activity Summary in the learner’s Activity Summaries
folder using a name you choose. When you save the Activity
Summary, you can open it later using Stages Report Wizard. The file
is saved in a unique format that allows Stages Report Wizard to
recreate the graphs and tables when you open it.

Click the Recreate a Stored Summary button to open a previously
saved Activity Summary. If there are graphs in your Activity
Summary, they will momentarily flash on the screen as Stages Report
Wizard automatically recreates them.

You can also open a stored Activity Summary by choosing the Open
Saved Summaries button at the “Choose a Learner” screen. Note that
because of the way in which these reports are generated, they are not
saved in a format that you can import into another application.
However you can create an electronic version (PDF file).

Click the Save this Summary button to create a PDF file that matches
the printed Activity Summary.

The first time you click this button (or the Annotated Report’'s PDF
button), you will be asked if you wish to install the PDF software. See
Appendix B, page 40, for details about the PDF software.

Macintosh Users:  Be sure to select the PrintToPDF printer in the
Chooser before clicking Create PDF file. After
creating the PDF, remember to return to the
Chooser to select your standard printer.

Windows Users:  After clicking Create PDF file, select PDF995 in the
drop-down printer menu of the print dialog box.

You will be asked to enter a name and choose a location to save the
PDF file. To open the PDF files, you will need Adobe Reader, which is
included on the Stages Report Wizard CD (see Appendix B).
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9. Entering Notes and Recommendations

Enter Notes and
Recommendations

L -—

At the Activity Summary screen, you can also choose to enter notes
about the learner and the activity. Click the Enter Notes and
Recommendations button to proceed.

This form can help you document areas such as the learner’s
academic objectives for the activity, off-computer practice
recommendations, and behavioral responses such as attention to task.

Notes and Recommendations for Sample Learner - Press and Hold
Tips

ObjECliVES Curriculum skill addressed:

IEP goal addressed:

Observations Recommendations

Attention to task: Skills to practice:

Related behaviors: Recommended software:

Access method notes: Off-computer practice:

Evaluator strategies used. Practice at home:

Learner will be reassessed on: ‘ ‘

Additional comments: ‘ ‘ g

Enter text as desired to clarify and expand upon the data in the

Activity Summary. The three general categories of Notes are:
% Objectives

Observations

Recommendations

R/
0.0
R/
0.0

You can also indicate the date for the next assessment, and any other
comments.

You may wish to compose and carefully check your notes in another
application. Select text that you want to place in one of the scrolling
Notes text boxes and select “Copy” from the application’s Edit menu.
In Stages Report Wizard, click on the text box where text should go,
then press Ctrl-V (Windows) or 3V (Mac) to paste the text there.

At the Activity Summary screen, you can add Notes and
Recommendations to the list of items to include in the Activity
Summary printout. They will be included in the Activity Summary
file when you click the Store this Summary to Recreate Later button.
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10. Questions and Answers

These questions and answers focus on methods and strategies for Stages Report Wizard. For
answers to trouble-shooting questions, see Appendix C.

When I organize each learner’s reports in folders, can I rename the reports?

Yes. Stages Report Wizard looks at the data in the file to determine the actual activity
name, date and time of the session. As long as the name of the activity has not been
altered in the report file itself, the Report Wizard can extract it. Other information that
may not be altered are the learner’s performance data for that activity and time/date
information in the report.

After  have added learners, can I change the names of their report folders?

Yes. Stages Report Wizard will automatically recognize that the learner’s Profile is the
same and update the file that keeps track of each learner’s folder name.

Can I change which folder Stages Report Wizard uses for my main reports folder?
Yes. If you wish to change to a different folder of Stages reports, choose “Update

Reports Folder Location” from the File menu. You will see the screen below. (You will
also see this screen if you move or rename your ‘My Stages Reports’ folder.)

Tips

Update 'My Stages Reports' Folder Location

Stages Report Wizard can't find your main folder of reports for your learners.
Perhaps you moved, renamed, or deleted this folder.

Click this button to show
Stages Report Wizard
where this folder is.

Click this button to

create a new 'My Stages Create My Manes
Reports' folder. Reports' Folder

Click the upper button to show Stages Report Wizard where your reports folder is. You
will see a folder selection dialog box similar to the one on page 7. If the folder you
choose hasn’t yet been set up for Stages learners, you will be asked if you want to add a
learner for each folder it finds. You can also click the lower button on this screen to
create a new "My Stages Reports’ folder.
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Q: How often should I make backup copies of my learner’s data?

A: We recommend that you make backup copies of your entire learner’s folder each time
you add reports to it or save Activity Summaries or Annotated Reports. It only takes a
minute or so to make the backup copies because the files are so small. Keep a floppy
disk handy for the backup copies, or copy the folder to a different hard drive, to a
removable disk or CD, or to another computer on your network. For instructions on
making copies of files, please refer to your computer’s on-line help system or user
manual.

Q: What do I do if I have Stages Assessment report files for learners on several different
computers?

A: You will need to copy the report files to a floppy disk, removable drive, or networked
computer in order to transfer them to the computer where you will use Stages Report
Wizard. The Stages report files are very small in size, so it is a quick process to copy
even hundreds of these files.

When you are ready to copy the report files to the computer where you will use Stages
Report Wizard, make a folder for each learner inside your ‘My Stages Reports” folder.
(If this folder isn’t already on your computer’s Desktop, start up Stages Report Wizard
and it will create one for you.) Then copy the files for each learner into his or her new
folder. When you start up Stages Report Wizard, it will help you add these learners to
your Learner List.

Q: Does it matter if the Stages reports were originally created on a Macintosh or Windows
computer?

A: No, Stages Report Wizard can read and work with both types of files. You can put both
types of files in a learner’s folder. Although there is a difference in the way Macintosh
and Windows computers save text files, Stages Report Wizard can compare reports
regardless of the type of computer on which they were originally saved.

Q: Can1open asaved Activity Summary in another application?

A: No, the Activity Summary is stored in a format that can only be used by Stages Report
Wizard. The file contains the data needed to recreate the graphs and tables. However,
you can create a PDF file if you want an electronic version of the Activity Summary
printout (see Appendix B). You can also copy any graph or table (using “Copy screen
image” from the Edit menu) and paste it into another application, such as Microsoft
Word. Then you can add your own comments and save it as a Word document.
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Appendix A:

Stages Reports

PDF Software

Folders

Activity Summaries

Annotated Reports

Stages Report Wizard Files

Stages Report Wizard creates several different folders and types of
files as you use it. You don’t need to learn about this information to
make the best use of Stages Report Wizard. It is provided to assist in
file management and trouble-shooting and for those curious about
how the program handles data.

Reports saved from the Stages Assessment Software are plain text
files. On Macintosh computers, they can be opened with SimpleText.
On Windows computers, they can be opened with NotePad or
WordPad.

If you modify the report files using these applications, they may not
be readable by Stages Report Wizard. If you open them to view them,
be careful not to add any text (even spaces or blank lines). If Stages
Report Wizard doesn’t list files stored in a learner’s folder of reports,
it may be because you have inadvertently modified them. If you open
a report and see an obvious error, such as blank line or the word
“Stage” misspelled at the beginning, you can correct it without
deleting any spaces (which may be tabs) and resave it.

The names of report files are not important to Stages Report Wizard.
The program gathers all the data from the contents of the file, not its
name or date of creation or modification.

For information about the PrintToPDF (Macintosh) and PDF995
(Windows) folders and files, please refer to Appendix B.

When you add a learner, Stages Report Wizard creates a folder named
Activity Summaries inside the new learner’s folder. This folder is
where all the Activity Summaries are automatically saved. When you
open a previously saved Activity Summary, Stages Report Wizard
will look for the summaries in this folder.

When you add a learner, Stages Report Wizard creates a folder named
Annotated Reports inside the new learner’s folder. This folder is
where all the Annotated Reports are automatically saved. When you
open a previously saved Annotated Report, Stages Report Wizard
will look for the reports in this folder.
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Files

ATI Prefs

Profiles.rwi

Prodef.rwd

learnerxwp

Stages Report Wizard preferences are stored in a folder named ATI
Prefs. On Macintosh computers, this folder is in the Preferences folder
of your System folder. On Windows computers, this folder is in the
Windows folder. This is the same location where all your Stages
preferences files are saved. If the folder does not already exist on your
computer, Stages Report Wizard will create it along with the Report
Wizard Prefs.txt file.

The Report Wizard Prefs.txt file stores the location of your ‘My Stages
Reports’ folder. It also stores information about whether you have
used Stages Report Wizard on the current computer and whether the
PDF software has been installed. It is safe to delete this file to create a
fresh computer environment on which to run Stages Report Wizard.

Also stored in this folder is a log file that captures messages from
Stages Report Wizard. If you ever encounter a problem using Stages
Report Wizard, the ATI Technical Support team may ask you to
e-mail this small file to help in trouble-shooting.

Each time you choose a different learner, Stages Report Wizard makes
a copy of his or her reports and sorts them into temporary folders in
the ATI Prefs folder. This allows you to keep reports both “loose” in
the learner’s folder, and also in folders within the learner’s folder. It
also prevents the potential problem of reports misfiled in incorrect
Stages folders within the learner’s folder.

The Profiles.rwi file is an index file of the names of all learners for
whom you have created profiles. This file stores the name of the
learner, the name of his or her folder of reports, and the location of his
or her profile file.

The Prodef.rwd file stores information about the school (name,
address, phone number) and teacher/evaluator (name and title) so
that you don’t have to type in the same school name and address for
every learner. This file is created or updated when you click the Save
school info as standard data button in the Profiles.

The .rwp file stores the demographic information about your learner,
which you entered in the Profile section. You choose the location of
this file when you click the Done button after entering the
information.

This file is automatically updated if you edit the learner’s profile. The
file name is generally the first character of the learner’s first name
followed by up to 7 letters of the learner’s last name. If another
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AnnotatedReport.rwl

ActivitySummary.xws

learner has already been assigned that name, Stages Report Wizard
will append a number to the filename so that each learner has a
unique name for his or her .rwp file.

An .rwl1 file contains all the information needed to recreate an
Annotated Report for one session. Clicking the Save this Annotated
Report button gives you an opportunity to name this file. Do not
change the .rw1l extension. The file is automatically saved in the
learner’s Annotated Reports folder. You can recreate Annotated
Reports to view and print by clicking the Open Saved Summaries
button at the “Choose a Learner” screen, going to the Annotated
Reports folder for a learner, and selecting the desired .rw1 file.

An rws file contains all the information needed to recreate an
Activity Summary for a set of reports. Clicking the Store this
Summary to Recreate Later button after viewing graphs and tables
for your set of reports gives you an opportunity to name this file. Do
not change the .rws extension. The file is automatically saved in the
learner’s Activity Summaries folder. You can recreate Activity
Summaries to view and print by clicking the Open Saved Summaries
button at the “Choose a Learner” screen, going to the Annotated
Reports folder for a learner, and selecting the desired .rws file.
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Appendix B: PDF Software

Assistive Technology, Inc. has licensed PDF software so that users of
Stages Report Wizard can keep an electronic version of their Activity
Summaries and Annotated Reports.

PDF stands for Portable Document Format. PDF files are created by
printing to a special printer driver that saves the content of a
document in this format. PDF documents can be read by either
Windows or Macintosh computers using Adobe Reader, which you
can install from the Stages Report Wizard CD, if it is not already
available on your computer.

The PDF software on the CD is distributed to users of Stages Report
Wizard under special licenses granted to Assistive Technology. Please
adhere to the licensing information supplied on the Stages Report
Wizard CD with respect to using this software. You are not allowed to
distribute this software to others.

Installing the PDF Software

The first time you run Stages Report Wizard on a computer and click
a button to create a PDF file, you will be asked if you wish to install
the PDF software.

If you answer ‘Yes’, the software will be automatically installed from
the Stages Report Wizard CD. If you answer ‘No’, you will be asked if
you ever wish to be asked again. (You may already have other
software that performs the same function and not need to install the
software.) If you choose not to install the software or be asked again,
and then change your mind, you can still install the software by
following the instructions below for your type of computer.

Using the PDF Software

Because the PDF-generating software is a printer driver, you need to
select a PDF printer to create the file.

Windows
The Windows utility program provided with Stages Report Wizard
for creating PDF files is PDF995.
The first time you click a PDF button in Stages Report Wizard, you
will have an opportunity to install this printer driver. Or you can
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install it at any time by double-clicking the file named autosetup.exe,
located in the PDF995 folder on the Stages Report Wizard CD.

To create a PDF of a Stages Report Wizard report summary, click the
PDF button and be sure to select PDF995 as the Printer Name in the
Print dialog box. You will be able to enter a name and select a location
to save the PDF file that is generated.

For more information about this product, visit www.pdf995.com.

Macintosh

The Macintosh utility program provided with Stages Report Wizard
for creating PDF files is PrintToPDEF.

The first time you click a PDF button in Stages Report Wizard, you
will have an opportunity to install this printer driver.

To create a PDF of a Stages Report Wizard report summary, open the
Chooser from the Apple menu and select the icon for the PrintToPDF
printer. Then click the PDF button on the Stages Report Wizard
screen. You will be able to enter a name and select a location to save
the PDF file that is generated.

To install PrintToPDF manually, after choosing not to have Stages
Report Wizard install it, follow these steps:

1. Copy the file named PrintToPDF from the PrintToPDF folder on
the Stages Report Wizard CD to the Extensions folder inside your
System folder. (If you drop it onto your System Folder, the Finder
will offer to place it in the Extensions folder.)

2. Copy the file named “PrintToPDF Site License” from the CD to
your Preferences folder inside your System Folder.

For more information about using this product, refer to the
PrintToPDF Manual, provided in the PrintToPDF folder on the Stages
Report Wizard CD.
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Appendix C: Trouble-Shooting

If you experience any difficulties using Stages Report Wizard, please refer to the following
table to try to identify and correct the situation. If you do not find a solution here, please
contact Technical Support at Assistive Technology, Inc. by telephone at 800-793-9227 or by
e-mail at techsupport@assistivetech.com.

Problem

Possible solution

After I choose an activity,
Stages Report Wizard tells
me that no reports were
found for that activity. I
know that the learner did
these activities.

Check the following possibilities:

% Did you save the reports after the learner completed the
activities using Stages?

Did you make sure to move or copy the reports into the learner’s
folder?

Is the learner’s folder in the “My Stages Reports’ folder?

Are the report files buried in folders deep in the learner’s folder?
(Stages Report Wizard will find them if they are in folders
directly in the learner’s folder, but not in folders that are inside
those folders.)

R/
0.0

X3

A

X3

A

Stages Report Wizard
seems to be confused about
my list of learners.

If Stages Report Wizard doesn’t display your list of learners correctly,
you can delete the file named Profiles.rwi. The next time you start up

Stages Report Wizard, it will rebuild your list of learners based on the
learners’ folders it finds in your ‘My Stages Reports’ folder.

Stages Report Wizard says
that it cannot read the data
in a file.

If you see a message that Stages Report Wizard cannot read the data, it
means that the file has been altered in some way. For example, a
person opening a saved Stages report file when Stages Report Wizard
was not running might have inadvertently entered a blank line. You
can open the file using SimpleText (on the Macintosh), Notepad (on
Windows), or Word (on either platform). Look to see if you can see
any obvious errors and if so, correct them, then save the file using a
different name. If you are using Word, be sure to save the document as
a ‘text only’ file. Do not change the extension of the file or Stages
Report Wizard will definitely not be able to use it. Please see
Appendix A for information about specific file types.

I told Stages Report Wizard
that I didn’t want to install
the PDF software. How can
I install it now?

Please refer to the installation instructions in Appendix B for your type
of computer.

I have received an error
message from Stages Report
Wizard. How can this error
be fixed?

If Stages Report Wizard notifies you of an error, information about it is
saved in a log file. You can e-mail this small log file to
techsupport@assistivetech.com to help us isolate and correct the
problem. The log file, named SRWlogfile.txt, is located in the ATI Prefs
folder on your computer. On Macintoshes, this folder is located in the
Preferences folder of your System Folder. On Windows computers,
this folder is located in the Windows directory. If you are running
Windows XP, the folder may be in a different location and you can
search for it by name to find it.
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Appendix D: A Quick Guide to Stages Report Wizard

Here is a summary of the steps you will most likely take to generate results from Stages
Report Wizard quickly. This guide assumes you have already created the ‘My Stages
Reports’ folder and have already set up learners and reports in their folders.

Step 1:  Select the learner.

Step 2: Update the learner’s Profile, if needed.

Step 3:  Select the Stage to work with.

Step 4:  Select the activity (and subactivity, if appropriate).

Step 5:  Select the set of reports for Graphs and Content Mastery tables.

Step 6:  View graphs and add comments and goal lines (where
applicable).

Step7:  View Content Mastery tables and add comments.

Step 8: At the Activity Summary screen, add Notes and
Recommendations, if desired.

Step 9:  Select items to include in the Activity Summary report.
Step 10:  Print the Activity Summary.
Step 11:  Create a PDF file of Activity Summary.

Step 12:  Save the Activity Summary.

Assistive Technology, Inc. page 43



NOTES

page 44 Stages Report Wizard User Guide



SOFTWARE LICENSE

PLEASE READ THIS SOFTWARE LICENSE AGREEMENT “LICENSE” CAREFULLY BEFORE USING THE SOFTWARE. BY USING
THE SOFTWARE, YOU ARE AGREEING TO BE BOUND BY THE TERMS OF THIS LICENSE. IF YOU DO NOT AGREE TO THE
TERMS OF THIS LICENSE, PROMPTLY RETURN THE SOFTWARE TO THE PLACE WHERE YOU OBTAINED IT FOR A REFUND.

1. License. The software accompanying this License whether on disk, in read-only memory, or on any other media (the “Software”) are
licensed, not sold, to you by Assistive Technology, Inc. You own the media on which the Software is recorded but Assistive Technology,
Inc. and/ or Assistive Technology’s licensor(s) retain title to the Software. The Software in this package and any copies which this License
authorizes you to make are subject to this License.

2. Permitted Use and Restrictions. This license allows you to install and use the Software on a single computer at a time. This License
does not allow the Software to exist on more than one computer at a time. You may make one copy of the Software in machine-readable
form for backup purposes only. The backup copy must include all copyright information contained on the original. Except as permitted
by applicable law and this License, you may not decompile, reverse engineer, disassemble, modify, rent, lease, loan, distribute,
sublicense, create derivative works from the Software or transmit the Software over a network. You may, however, transfer your rights
under this License provided you transfer the related documentation, this License, and a copy of the Software to a party who agrees to
accept the terms of this License and destroy any copies of the Software in your possession. Your rights under this License will terminate
automatically without notice from Assistive Technology, Inc. if you fail to comply with any term(s) of this License.

3. Limited Warranty on Media. Assistive Technology, Inc. warrants the media on which the Software is recorded to be free of defects in
materials and workmanship under normal use for a period of ninety (90) days from the date of original retail purchase. Your exclusive
remedy under this paragraph shall be, at Assistive Technology, Inc.’s option, a refund of the purchase price of the product containing the
Software or replacement of the Software which is returned to Assistive Technology, Inc. or an Assistive Technology, Inc. authorized
representative with a copy of the receipt. THIS LIMITED WARRANTY AND ANY IMPLIED WARRANTIES ON THE MEDIA
INCLUDING THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE LIMITED
IN DURATION TO NINETY (90) DAYS FROM THE DATE OF ORIGINAL RETAIL PURCHASE. SOME JURISDICTIONS DO NOT
ALLOW LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY LASTS, SO THIS LIMITATION MAY NOT APPLY TO YOU. THE
LIMITED WARRANTY SET FORTH HEREIN IS EXCLUSIVE AND IN LIEU OF ALL OTHERS, WHETHER ORAL OR WRITTEN,
EXPRESS OR IMPLIED. ASSISTIVE TECHNOLOGY, INC. SPECIFICALLY DISCLAIMS ALL OTHER WARRANTIES. THIS LIMITED
WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY BY
JURISDICTION.

4. Disclaimer of Warranty on Software. You expressly acknowledge and agree that use of the Software is at your sole risk. The
Software is provided “ASIS” and without warranty of any kind and Assistive Technology, Inc. and Assistive Technology, Inc.s
licensor(s) (for the purposes of provisions 4 and 5, Assistive Technology, Inc. and Assistive Technology, Inc.’s licensor(s) shall be
collectively referred to as Assistive Technology, Inc.) EXPRESSLY DISCLAIM ALL WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE. ASSISTIVE TECHNOLOGY, INC. DOES NOT WARRANT THAT THE FUNCTIONS
CONTAINED IN THE SOFTWARE WILL MEET YOUR REQUIREMENTS, OR THAT THE OPERATION OF THE SOFTWARE WILL BE
UNINTERRUPTED OR ERROR-FREE, OR THAT DEFECTS IN THE SOFTWARE WILL BE CORRECTED. FURTHERMORE, ASSISTIVE
TECHNOLOGY, INC. DOES NOT WARRANT OR MAKE ANY REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF
THE USE OF THE SOFTWARE OR RELATED DOCUMENTATION IN TERMS OF THEIR CORRECTNESS, ACCURACY,
RELIABILITY, OR OTHERWISE. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY ASSISTIVE TECHNOLOGY, INC.
OR AN ASSISTIVE TECHNOLOGY, INC. AUTHORIZED REPRESENTATIVE SHALL CREATE A WARRANTY OR IN ANY WAY
INCREASE THE SCOPE OF THIS WARRANTY. SHOULD THE SOFTWARE PROVE DEFECTIVE, YOU (AND NOT ASSISTIVE
TECHNOLOGY, INC. OR AN ASSISTIVE TECHNOLOGY, INC. AUTHORIZED REPRESENTATIVE) ASSUME THE ENTIRE COST OF
ALL NECESSARY SERVICING, REPAIR OR CORRECTION. SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED
WARRANTIES, SO THE ABOVE EXCLUSION MAY NOT APPLY TO YOU.

5. Limitation of Liability. UNDER NO CIRCUMSTANCES, INCLUDING NEGLIGENCE, SHALL ASSISTIVE TECHNOLOGY, INC.
BE LIABLE FOR ANY INCIDENTAL, SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES ARISING OUT OF OR RELATING TO
THIS LICENSE. SOME JURISDICTIONS DO NOT ALLOW THE LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES
SO THIS LIMITATION MAY NOT APPLY TO YOU. In no event shall Assistive Technology, Inc.’s total liability to you for all damages
exceed the amount paid for this License to the Software.

6. Export Law Assurances. You may not use or otherwise export or reexport the Software except as authorized by United States law and
the laws of the jurisdiction in which the Software was obtained. In particular, but without limitation, none of the Software may be used
or otherwise exported or reexported (i) into (or to a national or resident of) a United States embargoed country or (ii) to anyone on the
U.S. Treasury Department’s list of Specially Designated Nationals or the U.S. Department of Commerce’s Table of Denial Orders. By
using the Software, you represent and warrant that you are not located in, under control of, or a national or resident of any such country
or on any such list.

7. Government End Users. If the Software is supplied to the United States Government, the Software is classified as “restricted
computer software” as defined in clause 52.227-19 of the FAR. The United States Government’s rights to the Software are as provided in
clause 52.227-19 of the FAR.

8. Controlling Law and Severability. This License shall be governed by the laws of the United States and the Commonwealth of
Massachusetts. If for any reason a court of competent jurisdiction finds any provision, or portion thereof, to be unenforceable, the
remainder of this License shall continue in full force and effect.

9. Complete Agreement. This License constitutes the entire agreement between the parties with respect to the use of the Software and
supersedes all prior or contemporaneous understandings regarding such subject matter. No amendment to or modification of this
License will be binding unless in writing and signed by Assistive Technology, Inc.



